In this manual you find instructions for the pco.pixelfly usb scientific camera.

Target Audience: This camera is designed for use by technicians, engineers, and scientists.

In case of any questions or comments, please contact us at PCO.

<table>
<thead>
<tr>
<th>telephone</th>
<th>+49 (0) 9441 2005 50</th>
</tr>
</thead>
<tbody>
<tr>
<td>fax</td>
<td>+49 (0) 9441 2005 20</td>
</tr>
<tr>
<td>email</td>
<td><a href="mailto:info@pco.de">info@pco.de</a></td>
</tr>
<tr>
<td>postal address</td>
<td>PCO AG</td>
</tr>
<tr>
<td></td>
<td>Donaupark 11</td>
</tr>
<tr>
<td></td>
<td>93309 Kelheim, Germany</td>
</tr>
</tbody>
</table>

The cover photo shows an exemplary PCO camera system. The lens is sold separately.

Copyright © 2010 PCO AG (called PCO in the following text), Kelheim, Germany. All rights reserved. PCO assumes no responsibility for errors or omissions in these materials. These materials are provided "as is" without warranty of any kind, either expressed or implied, including but not limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement. PCO further does not warrant the accuracy or completeness of the information, text, graphics, links or other items contained within these materials. PCO shall not be liable for any special, indirect, incidental, or consequential damages, including without limitation, lost revenues or lost profits, which may result from the use of these materials. The information is subject to change without notice and does not represent a commitment on the part of PCO in the future. PCO hereby authorizes you to copy documents for non-commercial use within your organization only. In consideration of this authorization, you agree that any copy of these documents, which you make, shall retain all copyright and other proprietary notices contained herein. Each individual document published by PCO may contain other proprietary notices and copyright information relating to that individual document. Nothing contained herein shall be construed as conferring by implication or otherwise any license or right under any patent or trademark of PCO or any third party. Except as expressly provided, above nothing contained herein shall be construed as conferring any license or right under any PCO copyright. Note that any product, process, or technology in this document may be the subject of other intellectual property rights reserved by PCO, and may not be licensed hereunder.

Updated October 2010 © PCO AG
Table of Contents

1 Introduction .....................................................................................4
   The advantages of the pco.pixelfly usb for your success
2 Safety Instructions ............................................................................5
   Save money, reduce stress, stay healthy
3 System Components...........................................................................6
   What’s in the Box?
4 Installation ........................................................................................7
   Get your camera and computer ready for start.
5 Quick Start ........................................................................................8
   How to get an image fast and easy
6 Camera Control for the pco.pixelfly usb ........................................9
   The main interface for all camera settings
   6.1 The “Camera Control” window .................................................9
   6.2 The Timing sheet ......................................................................10
   6.3 The Sensor (Size) sheet ..........................................................11
   6.4 The Sensor (Misc.) sheet .......................................................12
   6.5 The Recording sheet ..............................................................14
7 Camware Features ............................................................................15
   Software for image acquisition and archiving
   7.1 If no camera is connected .....................................................15
   7.2 Overview ..................................................................................16
   7.3 The File Menu ..........................................................................17
   7.4 The Camera Menu ....................................................................18
   7.5 The Acquisition Menu ..........................................................21
   7.6 The View Menu ........................................................................23
   7.7 The Window Menu ...................................................................24
   7.8 The Help Menu ........................................................................25
   7.9 The Local Menu ....................................................................26
   7.10 Additional Features ...............................................................28

Appendix

A1 Technical Data ...............................................................................30
A2 Mechanical Dimensions .............................................................31
A3 Pinout of RJ11 Connector ...........................................................32
A4 Image File Formats .........................................................................33
A5 Service and Maintenance .............................................................35
A6 Customer Service and Trouble Shooting ....................................36
A7 Firmware Update ...........................................................................37
A8 Digital Camera Tools CD-ROM ..................................................38

About PCO .........................................................................................39
1 Introduction

Ultra compact high performance.

Features
This versatile high performance 14 bit CCD camera system has an extraordinary quantum efficiency of up to 62%. At the heart of the camera is a FPGA processor allowing for sophisticated control and accurate timing of the CCD and associated electronics. In addition, a proprietary offset control algorithm has been developed which provides very high offset stability, regardless of ambient temperature or signal changes, ensuring accurate and repeatable quantitative data over long periods of time.

The camera’s main features are:
• excellent resolution (1392 x 1040 pixel)
• superior quantum efficiency up to 62%
• 14 bit dynamic range
• superior low noise of 6e− rms @ 12MHz
• no glow functionality at long exposure times
• excellent DSNU at long exposure times
• optimal offset stability and control (<1count)
• hot pixel correction integrated
• USB2.0 interface

Areas of Application
scientific imaging low light level imaging
combustion imaging high resolution microscopy
luminescence spectroscopy quality control
spectroscopy fuel injection
particle image velocimetry (PIV) scintillation recording
bioluminescence / chemoluminescence material testing

flow visualization (hydrodynamics)
machinevision/industrial applications
imaging of bio markers (e.g. green fluorescent protein, GFP)
Red and NIR fluorescence applications
2 Safety Instructions

Never operate the camera in humid or dusty environments or in places with high amounts of X-ray radiation. **Humidity, dust or X-rays** could damage the camera.

To avoid the risk of water condensation, protect the camera against extreme changes of ambient temperature. **If condensation** enters the camera, there is the risk of electric shock.

To prevent damage to the camera, the system must be kept stable and protected against **strong jolts or vibrations**. The socket at the bottom of the camera is to be used for mounting purposes only.

Electric shock warning – **Never slide any items through the slits into the camera** because of the risk of electric shock if the voltage parts inside are touched.

Each time the camera is used, **check the power cable for any damage**.

Never position the cable in a way that it could become a **tripping hazard**.

**Do not force the lens onto the camera.** To protect the lens connector thread from damage, use minimal force when attaching a lens to the camera.

If any of the following conditions apply, immediately switch off the camera, separate it from the power line and contact our customer support:

- If the power cable or the power plug seems to be worn or damaged.
- If liquids have penetrated the device.
- If, after thoroughly reviewing the instruction manual, the device is still not operating properly.
- If the camera has been dropped or the casing is damaged.
3 System Components

The camera system includes the following parts.

Camera Head

C-mount optical connection:
The distance between the front edge of the c-mount and the sensor is 17.52 mm. For standard c-mount lenses and adapters.

DC Power Jack (connect to power supply)
USB 2.0 connector (connect to PC)
RJ11 (connect to I/O device)

LED indicates camera status
- green continuous: camera is ready
- green blinking: camera is in record state
- red continuous: error
- red blinking: boot loader
- red/green blinking: firmware update

M8
3/8-16 UNC threads for mounting
1/4-20 UNC

Serial Number tag

I/O Device
Proprietary RJ11-BNC connector for Trigger/Busy/Exposure signals

Power Supply
12V AC adapter with proprietary DSUB/BNC connection cable

Power Plug Adapter
Standard adapters for various countries

USB cable
USB-A/USB-B cable (5m)

Digital Camera Tools (CD-ROM)
The accompanying CD contains (see appendix A8):
• Camware: software for camera control & image acquisition
• camera driver & tools
• software development kit (SDK) and demo programs in C and C++
4 Installation

You will find all necessary files on the accompanying CD. You may also download the newest versions of our software, camera drivers, and third party software drivers from our website (support section).

Minimum system requirements:
- Clock speed > 1.6GHz
- RAM > 512MB
- Windows XP/ Service Pack 2
- 1280 x 1024 pixel resolution display
- 32-bit-graphics card (16.7 million colors)

4.1 USB 2.0

Please have the USB drivers and files downloaded on your computer. Connect camera with PC and connect camera to power.

4.2 Camera Driver

The first time the camera is connected via USB to the computer, Windows will notify the user that a new device has been detected. Afterwards, the typical Windows hardware drivers’ installation process will begin. At this point, you are asked for the location of the corresponding *.inf file.

Please click on the drive where the CD has been inserted or to the directory where the installation software has been downloaded. Windows will perform any further installation and system registration automatically.

4.3 Camware

The Camware 32-bit Windows application software enables you to control every camera parameter or setting. Images can be displayed on a monitor and may be downloaded and stored.

The CD runs automatically (if not: please begin the installation manually by double clicking on the setup.exe file). The installation software copies all necessary DLL files into the corresponding Windows directories. While doing this, older versions of these files will be replaced, if present. All required Windows registration entries will be made automatically. After a successful installation, you will find the program file 'Digital Camera Toolbox' in your program directory. Other helpful tools are also installed in the same file (see appendix A8).

To uninstall the Camware program, please use the Software feature under Window’s System Control.
5 Quick Start

Note: In order to get familiar with your new camera & software it might be helpful, if you first aim at an object that is easy to focus and that can be seen at standard light conditions.

5.1 Preparation

- installation is finished (see chapter 4)
- an appropriate lens is attached (remove cap!)
- or the camera is attached properly to the microscope, spectrograph or other scientific device
- camera is connected to the PC

- computer is on
- camera is connected to the power supply and ready (LED 'green')

5.2 Start

- start Camware
- open view window - if not already open -
- start "live preview"
- apply "auto range peak"
- you may adjust aperture and focus

You should now clearly see the object in the window.

- If you need to change exposure time (e.g. the image is still either too dark or too bright), please go to chapter 6!
- If you want to record and save images, please see chapter 6 and chapter 7 for detailed information!
6 Camera Control for the pco.pixelfly usb

The 'Camera Control' window in Camware is the main interface for all camera settings.

For further Camware features please see chapter 7!

6.1 The “Camera Control” window

The camera control window can be opened by selecting the proper command in the "Camera"-Menu or by the corresponding button in the toolbar:

The camera control dialog always adapts to the camera type connected. For the pco.pixelfly usb the camera control settings are spread over four property sheets, which will be explained below.

Changes to the camera control sheets must be completed by pressing the "Accept" button.

If the "Accept" button is not pressed, these changes will be ignored and lost. If the changes are within the allowed condition limits of the camera, a message is sent to the computer, the button disappears and the green lamp will be highlighted. If an illegal change was attempted, the camera will not accept the change and the red lamp will be highlighted.

In the information field you can view some information about the camera. Click into the info field in order to scroll through the values.

<table>
<thead>
<tr>
<th>Product: pco USB PixelFly (1392x1040), b/w, doubleshutter</th>
</tr>
</thead>
<tbody>
<tr>
<td>El. Temp.: 45 °C</td>
</tr>
<tr>
<td>Image size: 1392x1040, max. fps: 13.55</td>
</tr>
</tbody>
</table>
6.2 The “Timing” sheet

**Trigger Mode**

**[Auto Sequence]** The camera will optimize the image recording to achieve the best possible frame rate.

In the [auto sequence] exposure control mode, the camera determines the fastest possible image uptake rate depending on the adjusted exposure time and the required readout time. After a start command is given, the sequential recording is started until a stop command is given.

**[Soft Trigger]** Single images can be recorded with Camware control. The single image can be acquired by pressing the "Single Trigger" button. This button appears after pressing the “Start Record” button (see 7.2). Other signals cannot influence this operating mode.

**[External Exp. Start]** The image acquisition is triggered by an external signal. It is also possible to force a software trigger for a test image with the "Single Trigger" button.

In the [External Exp. Start] exposure control mode, single image recording is started by the falling or rising edge of the voltage signal at the BNC input (see appendix A3).

<table>
<thead>
<tr>
<th>pixel clock</th>
<th>intrinsic + system delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 MHz</td>
<td>5.6 µs</td>
</tr>
<tr>
<td>25 MHz</td>
<td>5.6 µs</td>
</tr>
</tbody>
</table>

**[External Exp. Ctrl]** not available for pco.pixelfly usb

**Timing**

The exposure time (delay time is not available for pco.pixelfly usb) can be adjusted in steps of 5µs.

<table>
<thead>
<tr>
<th>pco.pixelfly usb</th>
<th>exposure time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5µs ... 60s</td>
</tr>
</tbody>
</table>

The jitter of the actual exposure start edge: < 13ns
6.3 The “Sensor (Size)” sheet

**Binning**

Binning combines neighboring pixels (in either the horizontal or vertical direction) to form super pixels. It increases the light signal of the resulting pixels and decreases the spatial resolution of the total image, which is recorded. Vertical binning (x2) will also double the speed.

**Region of Interest**

The ROI (region of interest) selects only a part of the sensor to be read out, in order to speed up the frame rate and to save memory (not available for the pco.pixelfly usb).

**Sensor Format**

This sensor implementation provides the option to either readout the standard size (effective pixels recommended by the sensor manufacturer) or an alternative size of 800 x 600 pixel (center mode).
6.4 The “Sensor (Misc.)” sheet

Pixelclock

The pixel clock sets the clock frequency and therefore the image sensor readout speed. At 12 MHz the image quality will be higher due to very low readout noise (read out at a lower bandwidth). At 25 MHz the image sensor is read out with nearly double speed, achieving higher frame rates.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Pixelclock 12 MHz</th>
<th>Pixelclock 25 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1392 x 1040</td>
<td>7.3 fps</td>
<td>13.5 fps</td>
</tr>
<tr>
<td>800 x 600</td>
<td>11.7 fps</td>
<td>21.6 fps</td>
</tr>
</tbody>
</table>

Maximum frame rate: 40.5 fps (25 MHz, 800x600, V2 binning)

AD Converter

Feature not available for pco.pixelfly usb.

Double Image

This feature is widely used for particle image velocimetry (PIV) measurements. The first exposure time $t_{\text{exp}1}$ can be any exposure time of the available range of the pco.pixelfly usb camera. The second exposure time $t_{\text{exp}2}$ can not be directly adjusted. The length of the second exposure is exactly determined by the readout time of the first image. The interframing time $t_{\text{itf}}$ denotes the transition time between end of exposure #1 and start of exposure #2. See also appendix A3.

<table>
<thead>
<tr>
<th></th>
<th>12 MHz</th>
<th>25 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>$t_d + t_{\text{id}}$</td>
<td>5.6 μs</td>
<td>5.6 μs</td>
</tr>
<tr>
<td>$t_{\text{exp}}$</td>
<td>5μs ... 60s</td>
<td>5μs ... 60s</td>
</tr>
<tr>
<td>$t_{\text{read}}$</td>
<td>137 ms</td>
<td>74 ms</td>
</tr>
<tr>
<td>$t_{\text{itf}}$</td>
<td>1 μs</td>
<td>1 μs</td>
</tr>
</tbody>
</table>

$t_d$: trigger acknowledge delay
$t_{\text{id}}$: intrinsic delay
IR Sensitivity = Low Light Mode

This feature uses a special image sensor control method, allowing greater sensitivity in the near infrared spectral range (red line in graph), in most cases at the expense of decreased anti-blooming performance.

![Graph showing quantum efficiency of standard and low light modes.](image)

The integrated hot pixel correction is only active for standard mode. If you need to correct hot pixel in IR mode, please follow instructions under chapter 7.4 (Create Hot Pixel List).

Offset Control

Offset control is done automatically for optimal results. User control is disabled.

B/W Noise Filter

In the pco.pixelfly usb an optimal hot pixel correction is already integrated. For exposure times > 1s you might need extra Hot Pixel List (see page 21).

Conversion Factor

The conversion factor defines how many charges (electrons), which have been generated by light in the image sensor in each pixel, are necessary to generate one count (one intensity level) in the digital image. Therefore, the conversion factor describes the gain that is applied to the signal before it is converted into a digital value.

<table>
<thead>
<tr>
<th></th>
<th>conversion factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>pco.pixelfly usb</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Electronics Temperature

A digital temperature compensation is integrated instead of a space consuming thermo-electrical cooling unit. There is no additional fan.
6 Camera Control for the pco.pixelfly usb

6.5 The “Recording” sheet

Recording with the pco.pixelfly usb

The Camware will use free disk space on your computer. The recorded images will be temporarily saved as a 16bit multi TIFF under documents\settings\user\local\temp\PCO\cam0. Therefore, the camera runs in a virtual ‘Sequence’ Recorder Mode. The maximum number of images depends solely on the disk size of the computer.

Every new recording or shut-down of Camware will delete this temporary folder (including images!)

For further details on recording and saving images see the following chapters: 7.2; 7.3; 7.5!

Multiple cameras can be connected to one PC, but only one camera can record images under Camware (multiple cameras with SDK).

Features not available in the pco.pixelfly usb.
7 Camware Features

PCO’s renowned software for camera control, image acquisition, and archiving of images in various file formats.

You will find an online help under the common Help menu.

Note: There are some features explained in the online help that are not applicable for this camera version.

7.1 If no camera is connected

When Camware is started, it automatically recognizes the camera type, which is connected to the computer and switched on.

If Camware is started with no camera connected to the PC or with cameras switched off, it starts in demo mode.

In this mode all image processing features are available. The user only has to tell Camware which type of images will be opened. For that purpose, the “Demo Mode Setup” window opens and asks for the corresponding input.

Need Help? If this window pops up because you have trouble running the camera, please see instructions in appendix A6.

Resolution

The drop down list offers the existing image sensor spatial resolutions of all PCO camera systems. Please select the specific resolution and bit depth of the images to be opened! If double shutter images have been recorded and should be opened, “Double Shutter Mode” should be checked.

Color

With the radio buttons, the user can specify whether the image type is monochrome or color.

Alignment

These two radio buttons adjust whether MSB aligned (“upper”) or LSB aligned (“lower”) images have been stored (see page 18, “File Settings”).

Settings to view the b16 files of the pco.pixelfly usb:

<table>
<thead>
<tr>
<th>pco.pixelfly usb</th>
<th>Resolution</th>
<th>bit</th>
<th>DoubleShutter</th>
<th>Color</th>
<th>Alignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1392x1040</td>
<td>14</td>
<td>yes</td>
<td>&lt;yes&gt;</td>
<td>b/w</td>
<td>upper</td>
</tr>
</tbody>
</table>
7 Camware Features

7.2 Overview

Menu Bar

See chapter 7.3 - 7.8.

Local Menu

The “mouse right-click” is explained in chapter 7.9.

Toolbar

prints the currently displayed image or comment window

opens a b/w | color display window

opens the camera control window

opens the convert control

auto range peak/crop (see chapter 7.6 under “Convert Control BW”)

live preview: useful for fast and easy camera adjustment and focusing

This command disables the camera control window if it is opened!

soft trigger: captures a single image (see chapter 6.2)

Cursor display

cursor: pixel position and intensity value

continuous “auto range crop” scaling

Recorder

record START / STOP / PLAY

opens the recorder settings window

replay navigation

The ‘Recorder Browser’ gives an overview of the recorded images.

A click on the desired image makes it the current image in the Black/White or Color window.

“Skip #images” allows for convenient overview at large numbers of images.

With the “Multi Frame Window” it is possible to view all active camera images in one window. The user might select between “time” oriented or “camera number” oriented order.
7.3 The File Menu

Open Raw File (single image only)
This command should be used to import a single image into the currently active image window. Only files with the extension and format of "*.b16" (PCO proprietary binary image format) and "*.tif" (TIFF image format) can be imported. If the recorder is enabled, each imported image will be transferred to the buffer shown in the picture number. The image itself will be fitted to the current image size. If the recorder is disabled, the current image sizes will be set to the parameters of the imported image.

Open Raw File Set (for hsfc pro camera)
This command is used to open a set of images, previously saved with the 'Save Raw File Set' command. The corresponding windows will be opened automatically. Additionally a comment window will be opened, which shows the settings of the channel and a comment. This option is not accessible in case of the recorder is switched on.

Open Recorder Sequence (image sequence from one camera)
This command is used to import a sequence of images. If more than one camera is connected and an image window is currently open, the sequence will be loaded to the active window. If no image window is open, the images will be loaded to camera #1. This command opens the "Open file" dialog box. Only files with the extension and the format of "*.b16" and "*.tif" (TIFF16) can be imported.

Save Raw File (single image only)
The "Save" command should be used to save the image, which is displayed in the active window. The command opens the "Save file" dialog box. The image file can be saved in 16bit "*.b16" and "*.tif" format. If more than one camera is connected, it is possible to save all current images by selecting "Export all images" in the "Save file" dialog box. With this feature it is possible to save one image of each active camera within one process step (it is not necessary to repeat the save process for each camera). The "Save" command will not be available, if there is no image window open. See 6.5 for further information!

Save Raw Set (for hsfc pro camera)
To save one image of each active camera within one single b16 file.

Save Raw Recorder (image sequence from one camera)
The "Save Recorder" command should be used to save or export image records. If more than one camera is connected and an image window is currently open, the record of the active window will be saved. The command opens the "Save file" dialog box. If another image format than "*.b16" or "*.tif" (16bit) is chosen, image content will be lost, and it will be impossible to reload the images. The "Save Recorder" command will not be available, if there is no image window open. See 6.5 for further information!

Export File (not reloadable!)
Use this command to export the image in the active image window. This command will open the Save file dialog box. Files with the extensions "fts", "tif", "bmp", "asc", "jpg", and "jp2" can be exported. This item will be not visible, if there is no image window open.

Note: be aware of the different storage abilities of the formats, for example "*.bmp" - the bitmap format only allows for 8bit values to be stored and therefore the image content of a 12 or 14bit image is reduced, if stored as bitmap.
7 Camware Features

Export Recorder Sequence (not reloadable!)
Use this command to export a sequence of images. If more than one channel is connected and an image window is currently open the record of the window which has got the input focus will be saved. If no image window is open the images of channel 1 will be saved. This command will open the Export image dialog box. Files with the extensions "fts", "tif", "bmp", "asc", "avi", "mpg", "jpg", "jp2", and "wmv" can be exported.

If you export recorder files you will not be able to reload them into CamWare!

Print Setup
The "Print Setup" command opens the Windows "Print Setup" dialog box for adjustments and settings of the connected printer(s).

Print Preview
The "Print Preview" command opens a "Print Preview" window.

Print
Opens the Windows "Print" dialog box for the currently displayed image or comment display.

Options
This command opens the "Options" dialog, allowing special settings.

Options: File Settings

Tiff Bit Alignment
Here you can select the alignment of the pixel value. If this item is checked each pixel value is shifted from bit 12-1 to bit 16-5. This removes the 'dark image effect' inside other image applications.

Tiff RAW
Here you can select whether the 16bit RGB tif file is saved with 16bit raw or white balanced data. If this item is checked, each 16bit RGB pixel value is saved as raw 16bit RGB (48bit) value, without white balancing. Saving to 16bit RGB can be done by selecting the color display window, export recorder, selecting 8bit-tif (!) and checking 'Save 16bit RGB'.

ASCII file separator
Here you can select an appropriate separator for the ASCII file format.

Jpeg High Quality
Here you can select the quality of the saved jpeg/jp2 files. High quality saves images with 100% quality. Unchecking this option will create jpeg files with 85% quality.

Preserve Last Record
If checked, a message box will pop up in case the user may overwrite or lose data.
Options: View Settings

Image Browser
Here you can select between showing all image tiles inside the browser window either b/w or color. Setting b/w will result in a faster refresh (valid only for color CCD).

Marker
Use this command to display a cross in the centre of each image.

Convert (Min/Max) (“Continuous Auto Range Crop”, see chapter 7.6 under “Convert Control BW”)
This option enables the automatic min/max function during record and replay. Disable this feature if the application stops responding during this mode (due to operating system capacity problems).

Double Shutter:
This option enables the update of both double shutter images during record and replay. Disable this feature if the application stops responding during this mode (due to operating system capacity problems).

Options: Toolbar

Toolbar
Opens the corresponding toolbars (see 7.2)

Math. Functions
With the math window you have the ability to build the difference between a reference image and the actual image. If you activate math every new image acquired will be subtracted from the reference image or vice versa.

- last acquired image will be copied to reference buffer
- a reference picture will be acquired and copied to reference buffer
- add offset here to avoid negative values, which would not be visible
- enable / disable math function

Replay Speed Bar
The faster replay speed is useful if large sets of image data need to be scanned.
7 Camware Features

Options: Misc

Infotext
Use this command to show or hide the start-up information dialog box.

Synchronous Scrolling
If this item is checked all opened image windows will be scrolled at the same time and in the same manner.

View Embedded Image Info (for pixelfly and sensicam models)
If this item is checked an embedded text will be shown inside the image. See chapter 7.6.

Multi Win Picture Order
With the 'Multi Window' you have the ability to view the images of all active cameras in one window. You can select between 'time' oriented or 'camera number' oriented order. 'Time' oriented means that the sequence of images depends on the individual time stamp of each image. 'Camera number' oriented means that the first image shown is from camera 1, then camera 2 and so on.

LogFile
This option enables the logging of errors and system info. Enable this feature in order to create a support file, which can help to find out troubles with the cameras (see A6 “Customer Service and Trouble Shooting”).

Load lookup Table (for monochrome cameras)
With the Pseudo LUT feature you can load any LUT with one of four different formats and you can view the result in the color view window.

Use one of the attached predefined LUTs or define your own.

Direct Record To File
This command is intended for cameras with internal memory. In case of the pco.pixelfly usb images are recorded directly onto hard disk by default. With this command you can preset a certain number of images to be stored. If the camera captures images faster than the computer can save to disk, then you will loose images. The displaying of the images doesn't interfere with the record process.

Record with ‘Flowfile’ (for pixelfly and sensicam models)

Exit
This command exits the program and closes all channel dialog windows.

Window positions, settings and sizes are stored in the windows registry and will be loaded again at next start-up.
7.4 The Camera Menu

**Camera Control**
Use this command to open the camera control window (see 6.1).

**Load Camera Settings**
With this command you can reload camera settings which have been previously saved. You can reload only a file which has been made with the same camera configuration as it was found by the application at start-up.

**Save Camera Settings**
This command saves the actual camera settings of all existing cameras.

**Create Hot Pixel List (available with next Camware version V3.04)**
Use this command to create a ‘Hotpixel-File’. Some pixels tend to become very bright during a long exposure. These pixels are called hot pixel. To remove hot pixels from the image you have to create a hot pixel file first. If you have already a hot pixel file you only have to enable hot pixel correction. The new value of the hot pixel will be calculated from the values of the neighbour pixels. You only can create a hot pixel-file if the last exposure was longer than 5s.

This command will open the hot pixel dialog. You have to type in the desired count of hot pixels first. Then press the ‘Get Hotpixel’ button. After this the hot pixel list will be created, using the last acquired image. Now you have the possibility to save the hot pixel list for later use. All list box items with a checkmark will be saved to the hot pixel file. You can select or deselect a group of items by highlighting a group and pressing the checkmark in front of one of the highlighted items. Additionally you can open a local menu inside the list box by pressing the right mouse button. You can verify your selection by scrolling through the list and by a comparison to the average value shown in the dialog.

**Hotpixel Correction**
You can enable or disable the hot pixel correction. If hot pixel correction is disabled, a file dialog will be opened, in which you have to select the correct hot pixel file for the corresponding camera. If you have more than one camera connected you have to select the correct camera number first. If hot pixel correction is enabled this feature will be switched off.

**Auto Exposure**
Starts some exposures and tries to find an exposure time that captures images with grey values between 1400 and 1500. It re-adjusts the lookup tables in order to display the images with the new settings best.

In case the software is not able to calculate an appropriate setting, this message will be displayed.
7 Camware Features

7.5 The Acquisition Menu

Live Preview
The 'Live Preview' is useful for fast and easy adjusting and focusing of the camera. The active window will be updated. To see another window, simply click on the window. This option is not available in double shutter mode.

Acquire Picture
Records single images in case of pixelfly and sensicam cameras.

Acquire Sequence
Starts recording images into the system memory according to Trigger Mode selection (see 6.2). During the recording, the camera controls are locked.

Rec. Memory Settings
(for pixelfly and sensicam models)

Recorder Settings
This command opens the Recorder Settings dialog window.

The Play Settings are referred to the camera. If more than one camera is connected, the camera number is retrieved from the image window that has received the input focus (is active). If no image window is opened, the dialog is referred to camera 1. If the 'Set to all' checkbox is checked the settings apply to all connected cameras.

The Global Settings are valid for all connected cameras.

Averaging
If in the "Avg." dropdown list a value not equal to 1 is selected, the corresponding number of images is averaged in the buffer, reducing the statistically independent noise.

Another option to reduce the noise is the activation of the "IIR lowpass" IIR-filter: Image(act) = Image(act - 1) * 0.5 + Image(new) * 0.5

Replay Speed Slider
The slider can be used to adjust the sequence replay speed, from slow (turtle) to fast (rabbit).

Seq. Wrap Rec
Sequential Wrap Recording sets Recorder Mode (6.6) to “Ring Buffer”.

Seq. Wrap Play
The play button starts the display for a sequence as defined by the first image/last image fields and will loop until the stop button is pressed.

Reverse Play
If the "Reverse Play" box is checked, it is possible to play the recorded images in reverse.
7.6 The View Menu

**B/W Window**
Use this command to open a b/w display window.

**Color Window**
Use this command to open a color display window.

**Convert Control BW**

The user can influence how the 14 bit intensity values (x-axis) of the original image are converted into 8 bit values (y-axis) in different ways.

**Green sliders in histogram**
- **left slider = 'Min' controller** (corresponds to value "0" of the 8 bit display)
  - Values below that mark are set to "0", i.e. displayed as black.
- **right slider = 'Max' controller** (corresponds to value "255")
  - Values above that mark are set to "255", i.e. displayed as white.

The values in-between are converted into a value between "0" and "255" according to **Contrast** and **Gamma** settings. See the small graph, which reflects the calculation.

How the Auto Range applies:

- **Auto Range Peak** searches for the minimum and maximum 14 bit intensity values of the image. Given these number the converter scales the 8 bit display (256) within these two values.

- **Auto Range Crop** sets the converter to ignore the extreme intensity values of the image and scales the display in a smaller range. Thus dark or bright light spots, reflections, etc. are cut off.

- **Min/Max (Automatic) = Continuous Auto Range Crop**
7 Camware Features

**GPU Processing**
In order to benefit from all of Camware’s advanced processing features, we highly recommend a NVIDIA CUDA-enabled graphics processing unit (GPU). AMD's ATI graphics processing units are not yet enabled, but will follow soon.

### Camware Image Processing

<table>
<thead>
<tr>
<th></th>
<th>color</th>
<th>monochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre Processing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Noise Reduction</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Bayer Processing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bayer Demosaicing</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Sharpen</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Refine Process</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Chroma Blur</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Post Processing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offset, Gain (Min/Max)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Color Correction</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Saturation, Vibrance</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Color Temperature, Tint, White Balance</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Gamma, Contrast</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

*‘non local means’ algorithm*

---

**Convert Control Color**
This display will be shown only when you connect a color camera to one of your channels.

**Browser**
The ‘Recorder Browser’ gives an overview of the images in the Recorder, and helps you in an easy way to select a new current image. Simply click on the desired image to make it the current image. It may then be viewed in the Black/White and Color Window.
The Browser window can show up to 40 pictures per page, thus enabling easy printing of the Browser window. You can switch between the single pages by double clicking inside the Browser window or with the local menu (right mouse button).

‘Skip #images’ allows for convenient overview at large numbers of images.

**Multi Window**
View the images of all active cameras in consecutive order in one window. ‘Time’ oriented means that the sequence of images depends on the individual time stamp of each image. ‘Camera number’ oriented means that the first image shown is from camera 1, then camera 2 and so on.

**Embedded Image Info** (only for pixelfly and sensicam models)
see Timestamp feature in chapter 6.6
7.7 The Window Menu

**Cascade**
Show all windows overlapped.

**Tile**
Tile windows vertically or horizontally.

**Arrange Icons**
Rearranges all minimized topic icons on the desktop.

**Close All**
Close all windows.
7.8 The Help Menu

Contents
Opens the main page of the online program help.

Search for Help on
Opens an index list for help.

About
This window shows program information and contains helpful support links. In case of a camera problem, support files (see 7.3 Options/Misc/Logfile) may be generated, which can be automatically attached to the email. The support files contain relevant hardware information, the log files and the PCO related registry entries. These files are moved into a zip-archive called “CWSupport.zip”, which can be found in the application folder.
7.9 The Local Menu

The local menu is opened by clicking the right mouse button inside the client area of an image window.

**Image Properties**
Opens an information bubble with main image properties.

**Camera Control**
Opens the Camera Control window (see chapter 6).

**Convert Control BW/Color**
Opens the corresponding Convert Control windows (see 7.6).

**Zoom**
Changes the zoom used to display the image.

**Auto Range Peak/Crop**
Displays the image in a predefined scaling (see 7.6).

**Auto Balance Color**
The white balance feature for color cameras.

**Auto Exposure**
Auto Exposure feature (see 7.4)

**Flip**
The image will be flipped before display.

**Mirror**
The selected the image will be mirrored before display.

**Rotate**
The image will be rotated by 90° clockwise (right) or counterclockwise (left) before it is shown in the image window.

**Line Tool**
Select 'Line Tool' to show a graph, which shows the intensity of the pixels under the red line shown in the image window. The selection of this menu item determines the location of the first point. After this you can move the mouse to the second point, which can be selected by a 'left click'. Now a 'Line Diagram' opens and the length of the line (unit: pixel) is shown in a bubble and displayed in the window.

**Copy To Clipboard**
Copies the active image to clipboard.
7 Camware Features

7.10 Additional Features

Setting Contrast Area by Mouse
You can control the minimum and maximum values used for the conversion from 12 to 8 bit with the mouse. Move the mouse cursor into a region which should be shown with maximum contrast. Press the shift and the left mouse button. Hold down the mouse button while increasing the size of the rubber band window with mouse moves. After releasing of the mouse button the coordinates of the rubber band window act as a border for calculating the minimum and maximum values.

Setting a new ROI by Mouse
In the same manner you can setup a new region of interest (see ROI in Camera control) for the camera. You only have to press the CTRL (Strg) button instead of the shift button. The coordinates of the rubber band window are used for calculating a new region of interest. You can reset the ROI to maximum by pressing the CTRL (Strg) button and the right mouse button.

White Balance by Mouse
In the same manner you can change the ‘white balance’. You only have to press the CTRL (Strg) and the shift button at the same time. The pixel values within the coordinates of the rubber band window are used for calculating a new ‘white balance’.

For best results we recommend to use the white balance button in the ‘Convert Control Color’ (see 7.6) or the ‘Auto Balance Color’ in the Local Menu (see 7.9) respectively.

Fold Up Window
The Convert Control windows can be minimized/folded up. Just move the pointer over the bar and the window will unfold again.

Time Elapse Window
If an image is acquired with an exposure time longer than 5s, the time elapse window will appear to show the remaining time of the current exposure.
## A1 Technical Data

<table>
<thead>
<tr>
<th></th>
<th>unit</th>
<th>setpoint</th>
<th>pco.pixelfly usb</th>
</tr>
</thead>
<tbody>
<tr>
<td>resolution (hor x ver)</td>
<td>pixel</td>
<td>normal mode</td>
<td>1392 x 1040</td>
</tr>
<tr>
<td></td>
<td></td>
<td>center mode</td>
<td>800 x 600</td>
</tr>
<tr>
<td>pixel size (hor x ver)</td>
<td>µm²</td>
<td></td>
<td>6.45 x 6.45</td>
</tr>
<tr>
<td>sensor format</td>
<td>inch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sensor diagonal</td>
<td>mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>quantum efficiency (peak)</td>
<td>%</td>
<td>500nm typical</td>
<td>62</td>
</tr>
<tr>
<td>full well capacity</td>
<td>e⁻</td>
<td>full frame</td>
<td>16 000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>binning</td>
<td>24 000</td>
</tr>
<tr>
<td>dark current</td>
<td>e⁻/pixel·s</td>
<td>23 °C typical</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>45 °C typical</td>
<td></td>
</tr>
<tr>
<td>image sensor</td>
<td></td>
<td>ICX285AL</td>
<td></td>
</tr>
<tr>
<td>maximum dynamic range</td>
<td>dB</td>
<td>full frame</td>
<td>68.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2x2 binning</td>
<td>72</td>
</tr>
<tr>
<td>dynamic range A/D</td>
<td>bit</td>
<td>standard transfer mode</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>read out noise</td>
<td>e·rms</td>
<td>12 MHz</td>
<td>typ. 5 … 7 (max 10)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 MHz</td>
<td>typ. 6 … 8 (max 12)</td>
</tr>
<tr>
<td>imaging frequency (frame rate)</td>
<td>fps</td>
<td>12 / 24 MHz full frame</td>
<td>7.3 / 13.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 MHz center</td>
<td>11.7 / 21.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 MHz center V2 bin</td>
<td>40.4</td>
</tr>
<tr>
<td>A/D conversion factor</td>
<td>e⁻/count</td>
<td>standard / binning</td>
<td>1.0</td>
</tr>
<tr>
<td>spectral range</td>
<td>nm</td>
<td></td>
<td>290 … 1100</td>
</tr>
<tr>
<td>exposure time</td>
<td>µs</td>
<td></td>
<td>5 µs … 60 s</td>
</tr>
<tr>
<td>imaging frequency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(frame rate)</td>
<td>fps</td>
<td>12 / 24 MHz full frame</td>
<td>7.3 / 13.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 MHz center</td>
<td>11.7 / 21.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 MHz center V2 bin</td>
<td>40.4</td>
</tr>
<tr>
<td>anti-blooming factor</td>
<td></td>
<td>standard light mode</td>
<td>&gt; 400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>low light mode</td>
<td>&gt; 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(100 ms expos. time)</td>
<td></td>
</tr>
<tr>
<td>smear</td>
<td>%</td>
<td></td>
<td>&lt; 0.002</td>
</tr>
<tr>
<td>optical input</td>
<td>c-mount</td>
<td></td>
<td></td>
</tr>
<tr>
<td>trigger, auxiliary signals</td>
<td></td>
<td>internal / external</td>
<td>software / TTL</td>
</tr>
<tr>
<td>monitor signals</td>
<td></td>
<td>exposure &amp; busy</td>
<td>3.3 V LVTTL</td>
</tr>
<tr>
<td>binning (hor x ver)</td>
<td></td>
<td></td>
<td>1x1 … 2x2</td>
</tr>
<tr>
<td>power supply</td>
<td>VDC</td>
<td>range</td>
<td>9 … 28 V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>typical</td>
<td>12 V</td>
</tr>
<tr>
<td>power consumption</td>
<td>W</td>
<td></td>
<td>&lt; 4</td>
</tr>
<tr>
<td>mechanical dimensions</td>
<td>mm³</td>
<td></td>
<td>39 x 39 x 83</td>
</tr>
<tr>
<td></td>
<td></td>
<td>w/o socket</td>
<td></td>
</tr>
<tr>
<td>weight</td>
<td>kg</td>
<td></td>
<td>0.25</td>
</tr>
<tr>
<td>ambient temperature</td>
<td>°C</td>
<td>range</td>
<td>+10 … +45</td>
</tr>
<tr>
<td>operating humidity</td>
<td>%</td>
<td>range</td>
<td>10 … 80</td>
</tr>
<tr>
<td>storage temperature</td>
<td>°C</td>
<td>range</td>
<td>-20 … +70</td>
</tr>
<tr>
<td>data interface</td>
<td></td>
<td></td>
<td>USB 2.0</td>
</tr>
<tr>
<td>CE certified</td>
<td></td>
<td></td>
<td>yes</td>
</tr>
</tbody>
</table>

### Quantum Efficiency

![Quantum Efficiency Graph](measured_by_pco)

(measured by pco)
A2  Mechanical Dimensions

All dimensions given in millimeter.

Input Window | Filter

The input window of the pco.pixelfly usb camera contains a standard 300nm - 800nm AR coating (2%).
This window can be replaced by a filter (24mm diameter).

Carefully unscrew the black ring in front of the window and replace filter.
A3  Pinout of RJ11 Connector

<table>
<thead>
<tr>
<th>PIN</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>exposure</td>
</tr>
<tr>
<td>3</td>
<td>busy</td>
</tr>
<tr>
<td>4</td>
<td>not used</td>
</tr>
<tr>
<td>5</td>
<td>exposure trigger</td>
</tr>
<tr>
<td>6</td>
<td>+12V (alternative power supply)</td>
</tr>
</tbody>
</table>

**Pin Position**

**Timing & Signals**

busy = TRUE: camera is recording or sensor readout in progress
busy = FALSE: external trigger is accepted
exposure = TRUE: exposure of image sensor

In [Auto Sequence] trigger mode the busy signal is always set to TRUE, while the exposure signal indicates the real exposure of the image sensor.

In [External Exp. Start] trigger mode the camera is ready to accept a new trigger signal on PIN #5 (exposure trigger) when the busy signal is set to FALSE. After a successful trigger event the busy signal stays TRUE until the exposure is finished and the image is completely read out.
A4  Image File Formats

There are different file formats available for saving camera images with Camware.

b16
The “b16” 16 bit format is similar to the bmp format. However, 16 bit pixel values are used instead of 8 bit pixel values. The 16 bit pixel values represent “unsigned integer values”, where the camera (12 bit values) sets the higher 4 bits to zero.

The file format consists either of a “Basic Header” (6 Long-parameter) or of an “Extended Header” (32 Long-parameter), the latter of which is optionally for additional information. There might follow a variable comment field (ASCII code). Finally, there is the actual data set that is saved linearly (as in the case of BMP files).

With the exception of the first value, all parameters are "Long Integers" (4 Byte). The first 6 parameters must always exist. The rest of the parameters, as well as the comment field, are optional.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>&quot;PCO-&quot;</td>
</tr>
<tr>
<td>2</td>
<td>file size in byte</td>
</tr>
<tr>
<td>3</td>
<td>header length</td>
</tr>
<tr>
<td>4</td>
<td>image width in pixel</td>
</tr>
<tr>
<td>5</td>
<td>image height in pixel</td>
</tr>
<tr>
<td>6</td>
<td>extended header -1 (true), extended header follows</td>
</tr>
<tr>
<td>7</td>
<td>color mode 0 = black/white camera, 1 = color camera</td>
</tr>
<tr>
<td>8</td>
<td>b/w min black/white LUT-setting, minimum value</td>
</tr>
<tr>
<td>9</td>
<td>b/w max black/white LUT-setting, maximum value</td>
</tr>
<tr>
<td>10</td>
<td>b/w linlog black/white LUT-setting, 0 = linear, 1 = logarithmic</td>
</tr>
<tr>
<td>11</td>
<td>red min red LUT-setting, minimum value</td>
</tr>
<tr>
<td>12</td>
<td>red max red LUT-setting, maximum value</td>
</tr>
<tr>
<td>13</td>
<td>green min green LUT-setting, minimum value</td>
</tr>
<tr>
<td>14</td>
<td>green max green LUT-setting, maximum value</td>
</tr>
<tr>
<td>15</td>
<td>blue min blue LUT-setting, minimum value</td>
</tr>
<tr>
<td>16</td>
<td>blue max blue LUT-setting, maximum value</td>
</tr>
<tr>
<td>17</td>
<td>color linlog color LUT-setting, 0 = linear, 1 = logarithmic</td>
</tr>
<tr>
<td>18 - 266</td>
<td>internal use</td>
</tr>
</tbody>
</table>

Comment file in ASCII characters with variable length of 0...XX. The length of the comment file must be documented in the "header length" field.

16 bit pixel data

| line 1, pixel 1 | value of the first pixel |
| line 1, pixel 2 | value of the second pixel |

We recommend that all images should be saved first in the b16 or TIFF format. The advantage is to have the b16 or tiff images available all the time. You will always have the maximum 12 bit information. Please note that not all image analysis programs can accommodate 16 bit data. The 8 bit format saves only the information displayed on the monitor screen. The 12 bit information will be lost and cannot be displayed later.

TIFF
Tag Image File Format, version 6.0 and lower. There is a 16bit monochrome and color image format.

BMP
Windows Bitmap Format, b/w or color 8 bit format-images, which have been saved in BMP format can be loaded later only as 8 bit images, i.e. part of the original information (10bit, 12bit or 14bit) is lost.
Flexible Image Transport System, Version 3.1. There is a 16 bit image format. The NASA/Science Office of Standards and Technology (NOST) has defined this format. Some programs use the FIT extension for this format.

ASCII
16 bit format, some mathematical programs prefer ASCII data.

JPG
JPEG (named after the Joint Photographic Experts Group who created the standard) is a commonly used method of lossy compression for photographic images. The degree of compression can be adjusted, allowing a selectable tradeoff between storage size and image quality.

JP2
JPEG 2000 is a wavelet-based image compression standard and coding system. It was created by the Joint Photographic Experts Group committee in the year 2000 with the intention of superseding their original discrete cosine transform-based JPEG standard (created 1992).

AVI
Audio Video Interleave is a multimedia container format introduced by Microsoft in November 1992 as part of its Video for Windows technology.

MPG
MPEG-1, similar to JPEG, is a standard for lossy compression of video and audio developed by the Moving Picture Experts Group (MPEG).

WMV
Windows Media Video (WMV) is a compressed video compression format for several proprietary codecs developed by Microsoft. The original video format, known as WMV, was originally designed for Internet streaming applications, as a competitor to RealVideo.
A5 Service and Maintenance

Service
The camera is designed to operate with no need of special adjustments or periodic inspections.

Maintenance
Unplug the camera from any power supply before cleaning it.

Use a soft, dry cloth for cleaning the camera. Do not use liquid cleaners or sprays.

The lens is best cleaned with pressurized air or with liquid cleaners such as pure alcohol or with special optical cleaners that are available at high quality photo stores.

Never use aggressive cleaning liquids such as gasoline, acetone, spirits or nitro cleanser.

Every time the CCD window is cleaned, there is the possibility of surface damage. Do not clean the CCD window unless it is absolutely necessary. Be careful and avoid scratches and damage to the CCD window surface.

Use a cotton swab dipped in pure alcohol or optical cleaning liquid and wipe only on the glass surface. Do not get any cleaning liquid on the metallic parts such as the lens thread, because tiny detached particles may scratch the surface.

Always store the camera with the protective cap or with a lens mounted to avoid dust and dirt on the input window!

Camera Disposal
The camera includes electronic devices, which can contain materials harmful to the environment. If the camera is to be discarded, please dispose of it in an environmentally responsible manner and use recycling facilities, where available.
Appendix

A6 Customer Service and Trouble Shooting

If you have a question, which is not adequately addressed in this manual, please contact PCO or your local dealer.

To speed your request, we need the following information:

- Short description of the problem
- Description of your application
- Camera settings
- Type and version of camera software being used
- Camera serial number
- Power supply serial number (pco.power)
- Operating system (PC)
- Processor type (PC)
- Memory
- Graphic card
- Graphic card setup

Please use the email options under the Help menu (see 7.8), or go to our website: http://www.pco.de/support-request/

Before sending the camera for repair, first contact your local dealer or PCO respectively.

When shipping the camera for repair, be certain to carefully pack the camera with proper shipping materials. If possible use the original packaging. Use the protection cap to protect the camera on the lens thread.
A7  Firmware Update

Please contact our support team for further information and assistance!

mailto:support@pco.de
http://www.pco.de/support-request/
Appendix

A8 Digital Camera Tools CD-ROM

You find all necessary and some additional software and drivers on the accompanying CD. For the pco.pixelfly usb models please select “pco.camera”.

For the latest versions please check our website:

Image Converter

Use the PCO file converter to
- convert 16 bit tif and b16 images to various formats
- display file information
- show thumbnail images

Third Party Image Viewer for PCO b16 images

We recommend the free XnView (www.xnview.com), an efficient multimedia viewer, browser and converter. Please enable “all formats”.

pco.pixelfly usb User Manual V1.00 © PCO AG, Germany
PCO AG was founded in 1987. The company headquarters in Kelheim employs more than 50 specialists in the development and production of optimized, fast, sensitive camera systems for scientific applications. PCO’s range of products includes digital camera systems featuring high dynamics, extremely high sensitivity, high resolution, high speed, and extremely low noise, which are sold in industrial and scientific markets all over the world.

**Cameras for every point of view.**

The systems produced by PCO AG are cameras and scientific measuring instruments at the same time. Our high-tech systems are mostly the result of manual labor: over 50 highly specialized employees handle development and production at the Kelheim site. We deliver roughly 4,000 cameras a year to customers all over the world. As in every cutting edge technology, dialogue with the user is the main focus of PCO’s approach. Worldwide representatives, in cooperation with the in-house marketing division and technical support team, ensure that PCO camera systems are developed in step with the individual requirements of our customers.